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¡Felicidades por haber comprado una cámara Outdoor de Bushnell®! La cámara 
Outdoor se ha diseñado especialmente para capturar las memorias de sus mejores 
aventuras al aire libre, pues es resistente al agua, al polvo, a los golpes y está recubierta 
de caucho para ofrecer un agarre seguro. Por supuesto, con su flash automático  
y su capacidad de enfoque de cerca, también permite sacar fotografías excelentes  
en interiores.  

Antes de usar la cámara, lea las instrucciones que aparecen en este manual y tómese 
el tiempo necesario para familiarizarse con el funcionamiento y el gran número de 
funciones de la cámara.
 

GUÍA RÁPIDA: CÁMARA DIGITAL OUTDOOR DE BUSHNELL 11-0013G/Y

1 Instalar las pilas  
y la tarjeta de  
memoria (opcional)

Inserte 2 pilas AA alcalinas o de litio, como se indica, en el compartimiento para pilas situado en 
la parte inferior de la cámara. Para una mayor capacidad de almacenamiento de fotos, también se 
puede instalar una tarjeta SD (opcional) en la ranura para tarjeta interna, con la esquina muescada 
de la izquierda mirando hacia la pantalla LCD. 

2 Encender la cámara  Pulse y suelte el botón de encendido. Cuando se visualice en la pantalla LCD la revisión en vivo,  
estará listo para sacar una fotografía. La configuración predeterminada ofrece una calidad óptima en la  
mayoría de las condiciones. Sin embargo, le recomendamos que se lea el manual para aprovechar 
todas las opciones disponibles para diferentes condiciones fotográficas y preferencias del usuario. 

3 Fijar el idioma del 
menú y la Fecha/
Hora

Pulse el botón OK/Menú, luego la tecla de flecha izquierda para abrir el Menú de Modalidad. Pulse la 
tecla abajo dos veces para realzar “Set” (Fijar), luego use la tecla derecha para pasar a la lista del menú 
Set (Fijar). Baje hasta “Idioma” (Language), luego pulse la tecla derecha. Seleccione el idioma y pulse 
el botón OK. La pantalla regresa al menú Set (Fijar). Mantenga pulsada la tecla de flecha abajo hasta 
que aparezca resaltado “Fecha y Hora” (pase “Nombre de Archivo”), luego pulse la tecla derecha. En  
la pantalla de configuración de Fecha y Hora (Date/Time), use las flechas izquierda/derecha para  
seleccionar la parte de fecha/hora que quiera cambiar, luego use las flechas arriba/abajo para  
configurarla. La letra que hay al final de la línea de fecha configura el formato de fecha (A/M/D 
primero). La hora se puede configurar en un formato de a 12 ó 24 horas. Pulse OK cuando termine 
de configurar la Fecha y Hora. 

4 Formatear la tarjeta 
SD (opcional) 

Si insertó previamente una tarjeta SD, tiene que formatearla antes de usar la cámara. Vaya a  
“Format” (Formatear) en el Menú de Configuración (Set Menu), y pulse la tecla de flecha derecha. 
Baje a “Sí” y pulse OK para confirmar que quiere formatear la tarjeta. Pulse OK para salir de todos 
los menús.Observe que aunque la cámara sea resistente a la intemperie (resistencia al agua 

JIS Grado 4),no se debe usar debajo del agua, ni sumergir o lavar bajo un chorro 
de agua fuerte. Los daños ocasionados por el uso indebido no están cubiertos por  
la garantía.
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7. Monitor LCD 14. Ranura de la tarjeta SD 

8. Botón de encendido 15. Botón de Visión Rápida 

9. Visor 16. Receptáculos del trípode

10. Teclado táctil de 4 posiciones 17. Barra para correa

11. Botón de OK / Menú

12. Cubierta del compartimiento 
de las pilas

13. Pilas (AA x 2)

GUÍA RÁPIDA: CÁMARA DIGITAL OUTDOOR DE BUSHNELL 11-0013G/Y

5 Tomar una foto Pulse el botón del disparador hasta la mitad para poner el enfoque automático (se encenderá la luz AF 
verde), y luego pulse hasta abajo del todo cuando esté listo para sacar la foto. Las marcas de cuadro que 
aparecen en el centro de la pantalla LCD muestran el área que se usa para fijar el enfoque. Para sujetos 
que estén descentrados, coloque este cuadro sobre el sujeto principal, pulse el botón del disparador 
hasta que se encienda la luz AF, siga pulsándolo, y luego mueva la cámara para recomponer la imagen 
antes de pulsar el disparador totalmente para sacar la foto. Hay disponibles escenas preseleccionadas 
para paisajes, acción y retratos, consulte la sección “Dentro del Menú de Modalidad” para ver instruc-
ciones detalladas.

6 Revisar y  
borrar fotos

Pulse (y mantenga pulsado) Visión Rápida (Quick View) para revisar las fotos guardadas. Usando 
las teclas izquierda/derecha puede avanzar / retroceder por las fotos. Con las teclas arriba / abajo 
puede ver de cerca/lejos para inspeccionar todos las fotos con todo detalle. Para borrar una foto 
durante la revisión, pulse brevemente Visión Rápida (Quick View) (aparecerá el icono del cubo de 
basura). Pulse la tecla de flecha abajo para elegir Sí, luego pulse el botón OK para borrar la foto. Para  
terminar de revisar las fotos, pulse y mantenga pulsado Visión Rápida (Quick View).

7 Conectar a un 
ordenador/ 
computadora y 
transferir fotos

Antes de conectar la cámara, instale los controladores del CD-ROM si usa Windows 98/98SE,  
e instale PhotoSuite si todavía no tiene un software de edición de fotografías. Conecte el cable  
USB suministrado desde su PC hasta el puerto USB que está debajo de la cubierta del conector 
(encima de la correa). Pulse “OK” en la cámara. Si tiene Windows XP, sólo tiene que seguir las 
instrucciones/opciones que aparecen en pantalla. Si tiene Win 98 o 2000, abra Mi Ordenador/ 
computadora (My Computer) en su PC. La cámara se identifica como Disco Intercambiable  
(Removable Disk). Haga un doble clic en este “disco” y abra las carpetas que hay dentro. Seleccione 
cualquiera de estos archivos “.jpg”, o todos, y use Editar>Mover (o Copiar) a la Carpeta (Edit >Move 
(or Copy) to Folder) para guardar las fotos en Mis Fotografías (My Pictures) u otra carpeta del disco 
duro. Una vez transferidas, puede desconectar la cámara, y los archivos se pueden abrir, editar y volver 
a guardar usando el software PhotoSuite suministrado o cualquier otro software de formación de 
imágenes. Para más detalles, consulte “Cómo descargar las fotos paso a paso”.

Identificación de las Partes

1. Disparador

2. Visor

3. Flash

4. Cubierta del conector

5. Lente

6. Lámpara del disparador automático
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Iconos de la pantalla LCD # Indicador Iconos

6 Visualizar fecha 2004.06.20

7 Calidad de imagen (compresión) FQ / NQ / EQ 

8 Tamaño de imagen (resolución) 2048x1536, 1600x1200, 1280x960, 
1024x768, 800x600   

9 Barra de zoom digital 
 

10 Disparador automático
  

11 Macro

12 Secuencia de disparo (3 fotografías)

13 Modalidad de película

14 Equilibrio blanco

15 Patrón del medidor Centro          Promedio

16 Confi guración ISO AUTO ISO100 ISO200 ISO400

17 Valor de exposición (EV) -2 ~ +2

18 Auto Enfoque Indicador de área

Cómo poner las pilas  

Cómo insertar las tarjeta SD

Deslice el interruptor hacia el receptáculo del trípode como se 
muestra a la derecha, luego abra girando la cubierta de las pilas. 
Inserte 2 pilas alcalinas AA en la cámara, como se indica, y luego 
cierre la cubierta de las pilas hasta que encaje haciendo clic.

La cámara guarda 10-271 fotos en la memoria interna de 16MB, 
dependiendo de las confi guraciones de resolución/calidad (consulte el 
cuadro de la parte posterior de este manual). Para expandir la capacidad 
de almacenamiento disponible se puede añadir una tarjeta de memoria 
SD (“Seguro Digital”) opcional, con una capacidad de hasta 512 MB. 
La tarjeta se inserta en una ranura del compartimiento para pilas como 
se muestra en el último diagrama. Observe que la esquina “muescada” 
está en la izquierda, con los conectores de metal mirando hacia arriba.

# Indicador Iconos

1 Comprobar las pilas

2 Modalidad de disparo 
(Escena)

3 Modalidad de fl ash AUTO

4 Tarjeta SD insertada “SD”

5 No. de Fotos restantes [ 999]
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Cómo sacar una foto
Mantenga pulsado el botón de encendido durante 2 segundos para encender la  
cámara. Entonces aparecerá la pantalla de inicio del monitor LCD, y el indicador de 
carga de color rojo destellará brevemente. Cuando vea la visión previa de la imagen en 
vivo (1), la cámara está lista para sacar fotos. Componga su foto en la pantalla LCD (o 
use el visor si la pantalla LCD se ve con dificultad o las pilas están desgastadas). Pulse 
el disparador a medio recorrido para fijar el enfoque automático en el área central 
indicada por las marcas AF (2). Cuando se haya completado el enfoque, se encenderá 
la luz verde AF cerca del visor, y las marcas AF en la pantalla LCD cambiarán de 
rojo a verde (puede sacar una foto mientras las marcas estén todavía en rojo, pero  
es posible que no sea muy nítida). Para sujetos descentrados, enfoque con el área  
AF centrada en el sujeto, luego mueva la cámara según desee mientras continúa pulsando  
el disparador a medio recorrido. Pulse el disparador hasta abajo cuando esté  
preparado para sacar la foto (3). La pantalla LCD mostrará automáticamente una revisión  
rápida de la foto después de tomarla (el tiempo de revisión puede cambiarse en las  
configuraciones del Menú de Modalidad). Para apagar la pantalla LCD y no gastar las  
pilas, pulse el botón de Visión Rápida (Quick View) dos veces con rapidez (si lo  
mantiene pulsado se cambia a la modalidad de Revisión de Fotos).

1

2 3

Cómo usar el zoom digital
Pulse la tecla “T” (telefoto) del teclado   de flechas para acercar   el zoom (hasta 4 veces digitalmente). Si se pulsa 
la tecla “W” (ancho)   después de haber empezado a acercar el zoom regresará a un aumento normal. NOTA: en  
configuraciones altas del zoom digital, la imagen de la revisión previa puede aparecer “tosca” o suave a causa de las  
limitaciones de procesamiento en tiempo real. Este caso no representa la calidad real de la imagen captada, como podrá ver 
en la revisión rápida después de tomar la foto. Cuando el indicador AF se pone de color verde, se confirma que el enfoque 
está fijado y que el sujeto aparecerá tan nítido como sea posible en la foto final.

Cómo usar el flash

Cómo usar el macro enfoque y disparador automático

La configuración predeterminada al encender la cámara es Flash Automático (Auto Flash), lo cual significa que el flash sólo 
se dispara si se necesita en condiciones de luz escasa. Si se pulsa el botón derecho del teclado táctil de 4 posiciones  
seleccionará las demás opciones: reducción del efecto de ojo rojo   (un flash previo corto para reducir el tamaño de la 
pupila en los retratos), flash conectado (obliga a que se dispare el flash en condiciones brillantes-lo cual es bueno para 
llenar las sombras de la cara de una persona cuando el sol está detrás de la misma), y flash desconectado  (no se disparará 
en ninguna condición de luz-muy útil en museos y teatros donde está prohibido el flash). El icono correspondiente a la 
configuración presente de flash se visualiza en la pantalla LCD (ver “Iconos de la pantalla LCD”). NOTA: cuando esté en la 
modalidad de Flash Automático “normal”, no se verá ningún icono. Después de tomar una foto con flash, habrá un retraso 
de varios segundos antes de que se pueda tomar la siguiente foto, mientras se recargan los circuitos del flash.

Cuadro de área de  
enfoque automático  

   El macroenfoque le permite sacar objetos en primer plano en un radio de 10 a 60 cm (4” a 24”),  
aproximadamente. Para poner la cámara en la modalidad de macroenfoque, pulse el botón izquierdo del 
teclado táctil. El menú macro/disparador automático aparecerá en la pantalla LCD. Con el icono de macro 
(flor) realzado, pulse “OK” para seleccionarlo. El icono de macro se verá en la visión previa en la pantalla 
LCD. Sujete la cámara con firmeza y espere a que se encienda la luz de enfoque automático cuando tome la 
foto en la modalidad macro. Para regresar a la gama normal de enfoque, pulse el botón de tecla izquierda, 
seleccione macro otra vez y pulse OK. 
     Cuando está en el menú macro/disparador automático, si pulsa el botón abajo del teclado táctil se realzarán 
las opciones del disparador automático, lo cual le permite incluirse a sí mismo en una foto, donde dispone  
de 3 ó 10 segundos. Pulse OK con el tiempo deseado seleccionado. Con la cámara conectada a un trípode o  
sobre una superficie horizontal sólida, pulse el disparador-el disparador funcionará al final del tiempo marcado.  
El disparador automático es también útil para evitar que se mueva la cámara cuando se toman fotos de  
escenas nocturnas, ya que la cámara funcionará a velocidades del obturador menores. Para regresar a la  
operación normal del obturador, pulse el botón de tecla izquierda, seleccione el disparador automático presente,  
y pulse OK. 
     Pulse Cancel (Cancelar) mientras está en el menú macro/disparador automático para salir del mismo sin 
hacer una selección.

Menú 
Macro/ 

Disparador 
Automático  
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Cómo usar el menú principal
Si se pulsa el botón OK/Menú  que está debajo del teclado táctil de flechas se  
visualizarán las selecciones del menú principal en la pantalla LCD. Hay 2 menús 
“Abreviados” (Shortcut), que le permiten cambiar rápidamente el tamaño o la  
calidad de la foto, o cambiar a la modalidad de película, y un Menú de Modalidad que 
contiene múltiples configuraciones reunidas en grupos o “lengüetas”. Pulse el botón del 
teclado táctil en la misma dirección que el icono para que cada menú entre en el mismo. 
Los menús y sus funciones son :

Menú Icono Acción
Modalidad de 
película /
Modalidad de 
foto fija

         desde la modalidad 
de foto  

         desde la modalidad 
de película

Cambia de la modalidad de foto fija a la modalidad de película para 
grabar clips de vídeo (formato avi). Pulse la tecla “arriba” otra vez 
para pasar de la modalidad de película a foto fija.

Tamaño y  
calidad de 
imagen 

El tamaño de la imagen (archivo) se puede bajar desde 2048x1536 
hasta 800x600 pixels en 5 pasos. Los tamaños de imagen más 
grandes ofrecen una resolución más alta (nitidez) pero usan 
más memoria. La calidad de imagen se puede poner en “FQ”  
(calidad fina), “NQ” (normal ) o “EQ” (económica). Esto afecta a la  
cantidad de compresión de archivo .jpg, donde FQ es el archivo 
más grande con la menor compresión y la calidad más alta. Las 
configuraciones con el tamaño menor y la calidad más baja usarán 
menos memoria, y son aceptables si sólo necesita fotos pequeñas o 
las va a enviar por correo electrónico.

Pantalla de selección 
de menú   

Cómo usar el Menú principal continuación

Dentro del menú de modalidad-configuraciones adicionales

Pantalla del Menú de  
Modalidad, muestra 
(desde la izquierda) las 
columnas de Grupo,  
Ítem y Configuración.  
Use el teclado táctil de  
4 posiciones para moverse 
entre las mismas en 
cualquier dirección.  

Después de pulsar el botón OK/Menú para ver los 3 menús principales, 
use el botón derecho del teclado para abrir el Menú de Modalidad. Las 
selecciones que hay dentro del Menú de Modalidad están distribuidas 
en 3 grupos, o lengüetas, como se puede ver en la columna izquierda de  
la pantalla del Menú de Modalidad. Para seleccionar un grupo del  
menú, use los botones arriba/abajo. Luego pulse el botón derecho para  
pasar a la segunda columna, que muestra los ítems en ese grupo. Use de  
nuevo el botón arriba/abajo para ir al ítem que quiera, luego pulse la  
tecla derecha para pasar a la tercera columna y ver las configuraciones  
disponibles para ese ítem. Use los botones arriba/abajo para seleccionar la 
configuración que quiera, luego pulse el botón OK/Menú para confirmarla.  
Cuando termine de hacer sus configuraciones, siga pulsando el botón 
OK/Menú hasta que regrese a la visualización normal. Los grupos del 
Menú de Modalidad, y los submenús de ítem /configuración dentro de  
cada uno de ellos, se presentan en el orden siguiente (las configuraciones  
predeterminadas aparecen en negrita):

Nota: sólo se muestra  
el primer n° en el menú  
de tamaño:
2048 x 1536
1600 x 1280
1280 x 960
1024 x 768
800 x 600

Menú Icono Acción
Menú de Modalidad Abre menús adicionales como se describe  

a continuación.
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Dentro del menú de modalidad-Grupo/Ítem/Configuración 
Grupo Ítem Configur. Descripción

1: Exposic. Escena P (Programa) Exposición automática estándar para fotos normales

Paisaje           
Zona de enfoque más profunda para mayor nitidez desde el primer plano al fondo.

Retrato          
Una zona poco profunda de enfoque para fotos de personas-ayuda a aislar el 
sujeto del fondo.

Acción          
Usa velocidades de obturador más altas par ayudar a congelar el movimiento

Noche           
Usa velocidades de obturador más bajas para lograr una mejor exposición en 
condiciones de luz baja

Meter Centro La cámara fija la exposición basándose mayormente en el centro de la imagen. 
Es útil cuando el sujeto principal y el brillo de fondo difieren en gran medida.

Promedio La cámara fija la exposición basándose en la imagen en general. No hay icono en la 
pantalla LCD..

ISO Automát. La sensibilidad de la luz se fijará automáticamente desde ISO 100 ~400. 

100/200/400 Configuraciones manuales. Use un ISO más alto solamente en condiciones de 
luz baja.

EV -2.0 ~ +2.0 Proporciona ajustes de exposición por defecto o por exceso en incrementos 
de 0.3 EV

2: Color WB Automát. (A) El balance blanco se fija automáticamente para una reproducción de color correcta

Luz diurna           Configuración manual para condiciones soleadas al aire libre

Grupo Ítem Configur. Descripción

Nublado           Configuración manual para condiciones de cielos encapotados  
o de sombra al aire libre

Tungsteno     
Configuración manual para luz interior de tungsteno (bombillas)

Fluorescente 
Configuración manual para luz interior fluorescente 

Mod de 
Color 

Color Reproducción de color normal 

Blanco y negro Sólo para fotografía en blanco y negro

Sepia Efectos especiales para lograr un aspecto de fotografía “antigua”

Contraste Alto Contraste mejorado para días nublados o luz plana

Normal Contraste medio para la mayoría de las escenas

Bajo Contraste reducido para mediodía u otras condiciones de alto contraste 

3: Fijar Repos.
Todo

No / Sí Seleccione “Sí” y pulse el botón “OK/Menú” para borrar todas las  
configuraciones del usuario y restaurar las configuraciones predeterminadas

Formato No / Sí Seleccione “Sí”, luego pulse el botón “OK” para formatear (preparar)  
una tarjeta SD insertada (opcional). Precaución: de esta forma se  
borrarán todas los archivos previamente almacenados en la tarjeta. 

Dentro del menú de modalidad-Grupo/Ítem/Configuración continuación
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Dentro del menú de modalidad-Grupo/Ítem/Configuración continuación

Grupo Ítem Configur. Descripción

Idioma Inglés/Español/ 
Francés/Alemán/ 
Italiano/Portugués

Selecciona el idioma que se visualiza en todos los menús

Ver Grab Off, 1, 2, ó 3 seg. Fija la duración de la visualización de la revisión de la foto después de tomar 
la foto

Nombre de 
Archivo

Reposición.  
o Serie

Numeración de archivos para fotografías nuevas después de borrar todas comienza 
en “1” (Reposición), o sigue avanzando desde el último número usado (Serie)

Brillo de 
LCD 

Poner en cualquiera 
de 7 niveles 

Fija el brillo de la pantalla. Casilla izquierda=más tenue, casilla derecha=
más brillante. La casilla intermedia es el nivel normal. Pulse OK para fijarla.

Fecha y Hora > para ir a setup. 
Pulse “OK” una 
vez fijado.

Las teclas izquierda/derecha mueven entre campos. Las teclas arriba/abajo 
cambian de configuración. La letra al final de la fecha fija el formato:  
M, D, o A primero.

Salida de 
vídeo

NTSC o PAL Afecta la señal del vídeo de salida. Se debe fijar para el sistema de TV de un 
lugar dado.

Mod de Grab 1-Disparo o  
3-Disparos

Fija el número de fotos tomadas cada vez que se pulsa el disparador automático. 
1-disparo es un disparo normal, 3-disparos toma 3 fotos en una serie rápida para 
captar una secuencia de acción.

Almace-
namiento

Auto Los archivos se guardan en la tarjeta SD si está insertada, en la memoria RAM 
interna si no está insertada

SD Card Los archivos se guardan solamente en la tarjeta SD (tiene que estar insertada)

Cómo revisar y borrar fotos guardadas
Para revisar (reproducir) las fotos guardadas en la memoria interna o en la tarjeta SD, pulse y mantenga pulsado el 
botón Visión Rápida (Quick View) hasta que la pantalla muestre su foto previa. Use los botones izquierdo/derecho 
del teclado táctil para moverse hacia adelante o hacia atrás por sus fotos. Mientras se visualiza una foto, si se pulsa 
el botón “arriba” se comenzará a hacer un zoom sobre la imagen (aumentando 4 veces). Es útil para verificar si la 
foto es nítida. Después de hacer un zoom, puede pulsar “OK” y luego usar el teclado táctil de 4 posiciones para ver 
diferentes áreas de la foto (pulse OK otra vez para salir). Después de hacer un zoom, puede pulsar el botón abajo 
para salir del zoom. Si se pulsa el botón abajo cuando la foto se visualiza normalmente (sin zoom) se cambiará a una 
visión general de múltiples fotos (hasta 9 a la vez), visualizando imágenes de reseña (thumbnail) de todas las fotos. 
Entonces puede usar el teclado táctil para realzar una foto especial, y visualizarla en pantalla completa pulsando 
el botón OK/Menú. Para eliminar (borrar) una foto durante la revisión, pulse brevemente (sin mantener pulsado) 
el botón de Visión Rápida (Quick View). Entonces aparecerá el Menú Eliminar (Borrar), con la opción de Una o 
Todas. Pulse la tecla abajo (seleccione “Una”), luego acepte OK para borrar solamente esa foto. Verá un “reloj de 
arena” destellando a medida que se borran las fotos. Observe que si se pulsa el botón OK después de seleccionar 
“Una” o “Todas”, las fotos se borrarán inmediatamente, así que tenga cuidado de no seleccionar “Todas” si antes no 
ha transferido las fotos a su PC. Cuando termine de revisar las fotos, pulse y mantenga pulsado el botón de Visión 
Rápida (Quick View) para volver a la visualización de visión previa en vivo. 

Revisar Menús
Después de pulsar el botón de Visión Rápida (Quick View) para entrar en  
la modalidad de Revisión (Review), si se pulsa el botón OK/Menú entrará  
la serie de menús de revisión. Así se opera de la misma forma descrita  
previamente en las instrucciones del Menú de Modalidad de foto fija (use  
las teclas del teclado táctil de flechas para pasar al menú deseado, pulse  
OK para confirmar una configuración), pero con diferente ítem y configuración 
de menús, tal como sigue:

Modalidad de Revisión:   
Visualización de  
menú principal

Interna Los archivos sólo se guardan en la memoria interna, nunca en la tarjeta 
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Menú Icono Acción

Programa de 
diapositivas

 Recorre automáticamente un ciclo por las fotos guardadas, comenzando por la más antigua.  
Pulse la tecla de flecha arriba para empezar el programa. Se detendrá en la foto más reciente  
que se haya tomado y regresará a la modalidad de revisión normal.

Inform. Fija si la información (No. de archivo, tamaño y calidad de la imagen, fecha/hora) de cada  
foto se visualiza o no durante la modalidad de revisión. No afecta permanentemente la  
información almacenada.

Revisar Menú  
de Modalidad

Abre configuraciones adicionales como se describe en la siguiente sección

Revisar Menús continuación

Revisar las configuraciones del menú de modalidad
Grupo Ítem Configuración Descripción

1: Reproducir Proteger Off / On Fijarlo en “On” bloquea la capacidad de borrar fotos hasta que se vuelva 
a poner “Off” en este menú. Evita que se borre una foto por accidente.

Rotar 90 grados > o < Gira la visualización de la foto revisada. Elimina la necesidad de girar la 
cámara para revisar las fotos tomadas con la cámara en posición vertical 
(retratos verticales, etc.) 

2: Color Blanco y 
negro

Off / On Crea una versión adicional en blanco y negro (nuevo archivo) de la foto 
revisada presente (deje pasar varios segundos). El archivo de la foto con 
el color original no se ve afectado.

Grupo Ítem Configuración Descripción

Sepia Off / On Vea la descripción en blanco y negro. Con el efecto de tono sepia.

Copiar a tarjeta SD No / Sí Copia todo el contenido de la memoria interna en la tarjeta SD

Formatear No / Sí Formatea la tarjeta SD insertada, borrando todo el contenido.

3: Fijar Reponer todo No / Sí Seleccione “Sí” y pulse el botón “OK/Menú” para borrar todas las  
configuraciones del usuario y restaurar las configuraciones predeterminadas

Idioma Como se describió previamente en la sección del Menú de Modalidad de Foto

Brillo de LCD Como se describió previamente en la sección del Menú de Modalidad de Foto

Fecha y hora Como se describió previamente en la sección del Menú de Modalidad de Foto

Salida de vídeo Como se describió previamente en la sección del Menú de Modalidad de Foto

Revisar las configuraciones del menú de modalidad continuación

Modalidad de película-operación y Menús
Desde la modalidad de Foto, con la visión previa visualizada, pulse OK/Menú para ir a los menús principales. Pulse el  
botón arriba del teclado táctil para cambiar a la modalidad de Película. Se visualizará el icono          de película. Seleccione  
la resolución “320” ó “160” pulsando OK/Menú y luego la tecla izquierda. Pulse el disparador para empezar a grabar 
un clip de vídeo (formato avi), y pulse otra vez para parar el vídeo. Para reproducir la película de vídeo, mantenga 
pulsado Visión Rápida (Quick View) hasta que la pantalla cambie a Review [Revisar] (verá la primera imagen de la 
película). Pulse el disparador para comenzar la reproducción. Pulse Visión Rápida (Quick View) brevemente para ir 
al menú Delete (Borrar). Cuando haya terminado de sacar los vídeos, pulse OK para el menú principal, luego el botón 
arriba (icono de cámara fija) para regresar a la modalidad de foto normal. Observe las siguientes diferencias de opciones 
de menú/funciones para la Modalidad de Película frente a la Modalidad de Foto:
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Requisitos del sistema (Mínimos)

Instalación del software 

Cómo descargar sus fotos – paso a paso

SO: Windows® 98/98SE/2000/ME/XP
CPU: MMX Pentium® 200MHZ equivalente o más rápido (Pentium® III 500 MHz para PhotoSuite5™)
Memoria: 32MB mínimo (64MB recomendado para PhotoSuite)
Tarjeta de vídeo SVGA c/2MB VRAM, pantalla de 800x600, color alto de 16 bit
200 MB de espacio disponible en disco duro (si se instala PhotoSuite)
Puerto USB interno

Si usa Windows 98, tiene que instalar los controladores antes de conectar la cámara a su PC. Inserte el CD-ROM en la 
unidad para CD de su ordenador/computadora; se ejecutará automáticamente y se visualizará la pantalla de instalación. 
Seleccione Instalar Controlador (Install Driver), y luego siga las instrucciones. Después de la instalación, vuelva a reiniciar 
su ordenador/computadora. Windows 2000, ME y XP no requieren controladores, ya que la cámara usa el estándar de 
almacenamiento masivo USB, lo cual permite que los archivos fotográficos se puedan acceder como si estuvieran guardados 
en una unidad de disco duro externa. Los que usen cualquier sistema operativo de Windows, si todavía no usan un software 
de edición de fotos de su preferencia, pueden instalar Roxio PhotoSuite® que viene en el CD-ROM. Cerciórese de leer 
completamente las “Notas de publicación”, observando los consejos o los problemas potenciales que estén relacionados con 
la configuración y el sistema operativo de su PC.

1. Cerciórese de que primero se haya instalado el controlador si tiene Windows 98/98SE.
2. Encienda la cámara y conecte el cable suministrado al receptáculo de USB de la cámara (abra la 
cubierta del conector del lado de la correa de la cámara), luego conéctelo directamente al puerto USB 
principal de su ordenador/computadora-no use los puertos USB del panel delantero/teclado ni una 
“conexión múltiple de USB” que no tenga corriente propia.
3. La cámara presentará la pantalla de Transferencia (Transfer), con el icono del PC resaltado. Pulse 
“OK”, la pantalla cambiará a Almacenamiento Masivo (Mass Storage). En caso contrario, cierre todos 
los programas que estén abiertos, desconecte la cámara, reinicie su ordenador/computadora y vuelva 
a intentarlo.

Pantalla  
Descargar    

Modalidad de película-operación y Menús continuación 
En la modalidad de película, todas las funciones y opciones de menú son idénticas 
a las de la modalidad normal de foto fija con las siguientes excepciones:
• No hay disponibles opciones de preselección de escenas (paisaje, retrato, etc.)
• No hay opciones de modalidad de grabación (secuencia 3x).
•  Las opciones de tamaño de imagen disponibles son 320x240 ó 160x120. De esta forma se fija la resolución 

de película por imagen. Si se cambia a la resolución 160x120 se dispone de un tiempo de grabación 4 veces 
mayor que en 320x240, pero con una calidad menor. La frecuencia de imagen se prefija en 20 imágenes  
por segundo.

•  No se ofrecen opciones de calidad (compresión de archivo).
•  Antes de comenzar a grabar un vídeo, el contador de la parte derecha inferior de la pantalla LCD muestra 

el tiempo de grabación disponible en segundos (31”, 124”, etc.)
•  Mientras se graba el vídeo, el contador muestra los segundos transcurridos.
•  El zoom y el macroenfoque no están disponibles, el flash se fija en “Off”
•  Si la cámara se apaga mientras está en la modalidad de película, regresará a la modalidad de foto fija cuando 

se vuelva a encender. 

 
Nota: Si su PC no reproduce las películas  .avi en Windows Media Player, puede que tenga que descargar una 
versión más reciente desde Microsoft.com (busque “descargar media player”). Los archivos de película se pueden 
reproducir también con QuickTime Player, incluido en muchos ordenadores/computadoras, o disponible para  
descargar gratis desde Apple.com.
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Cómo se usa la función de imprimir directamente (Pictbridge)
La cámara Outdoor permite también imprimir directamente desde la cámara hasta impresora  
compatibles con PictBridge, sin usar un PC. Le recomendamos que se lea primero la sección  
de imprimir directamente/PictBridge del manual de su impresora. Con la impresora encendida, 
conecte el cable USB suministrado a la cámara, luego al puerto USB de imprimir directamente que 
está situado en la parte frontal o lateral de la impresora. La pantalla de la cámara se debe encender 
(en caso contrario, encienda la cámara). Seleccione el icono de la impresora (1), y pulse “OK”. 
Después de un breve retraso, mientras se establece la comunicación entre la cámara y la impresora, 
deberá ver el menú de opciones Imprimir (2). Use las teclas arriba/abajo normales para seleccionar 
una opción de imprimir, luego pulse OK. Las opciones son (por orden desde el icono superior 
hasta el inferior):

1

2

1. Imprimir Una (Use las teclas izquierda/derecha para seleccionar la imagen, arriba/abajo para 
seleccionar el número de copias que desee imprimir. Pulse OK cuando esté listo para imprimir).
2. Imprimir Todas las Imágenes (No/Sí). Imprime todas las fotos guardadas en la cámara.
3. Imprimir Foto Seleccionada de una Revisión de Reseña (use las teclas izquierda/derecha para 
seleccionar una foto, arriba/abajo para elegir cuántas copias desea.)
4. Imprimir Todas las Imágenes como Índice: imprime reseñas de todas las fotos (“hoja  
de contacto”)
5. Salir del menú de imprimir.

4. Abra Mi Ordenador/computadora (My Computer) o Windows Explorer. La cámara se considerará como un Disco 
Intercambiable (Removable Disk) nuevo con una letra de unidad de disco sin usar asignada a la misma. Haga doble clic en 
este icono de nuevo “Disco”, abra la carpeta “DCIM” que tiene dentro y luego cualquier carpeta que haya dentro de la misma 
(“100BUSHN”, etc.) Sus fotos son archivos JPEG dentro de la misma-con el prefijo “BUSH__” seguidos por un número, 
igual que vimos antes en la pantalla de la cámara cuando se revisan las fotos. Si se hace clic en cualquier archivo se debe mostrar 
una imagen pequeña de visión previa.
5. Haga clic en Editar>Seleccionar Todas (Edit>Select All), o haga clic en una foto, contol+clic para seleccionar múltiples fotos, 
luego Editar>Copiar a Carpet [Edit>Copy to Folder] (en los menús de Windows). Seleccione una carpeta existente del disco 
duro, tal como Mis Fotografías (My Pictures), o cree una carpeta nueva (“Vacaciones de 2004”, etc.), luego haga clic en “OK” 
para transferir las copias de los archivos de foto que quiera.
6. Después de transferir las fotos a su disco duro, puede desconectar la cámara. Windows puede hacer una advertencia en 
pantalla diciéndole que ha desconectado un dispositivo USB sin parar o expulsar el “disco” primero (sus archivos fotográficos 
no se dañarán). En este caso, marque la casilla que añade un icono a la bandeja o barra de tareas de su sistema. Entonces, la 
próxima vez que termine de transferir las fotos puede hacer clic primero en ese icono, y “Parar el dispositivo de almacenamiento 
masivo USB” antes de desconectar la cámara.
7. Ahora está listo para abrir los archivos de fotos con cualquier software de edición de fotografías. Sólo tiene que usar 
Archivo>Abrir (File>Open) e ir a la carpeta donde guardó las fotos antes. Si está usando PhotoSuite, seleccione Archivo>Abrir 
Foto (File>Open Photo), luego use el menú desplegable Mirar (Look in) de la parte superior de la ventana Abrir (Open), 
seleccione Mi Ordenador/computadora (My Computer”), seleccione su disco duro, y haga doble clic en cualquier foto de 
la carpeta en donde copió las fotos desde la cámara. También es posible abrir y trabajar con sus fotos directamente desde la 
cámara Outdoor mientras está conectada todavía. Para hacer esto con PhotoSuite, primero siga los pasos 1 a 3, luego abra 
PhotoSuite, seleccione Archivo>Abrir Foto (File>Open Photo) y use el menú Mirar (Look in) para seleccionar Mi Ordenador/
computadora (My Computer), luego seleccione el Disco Intercambiable (Removable Disk), y abra las carpetas que haya dentro 
hasta que llegue a los archivos fotográficos JPEG. Si decide trabajar de esta forma, desde una cámara conectada, cerciórese de 
guardar las fotos (cuando termine de editar) en su unidad de disco duro, y no en la memoria o la tarjeta de la cámara. Para 
hacerlo en PhotoSuite, después de hacer clic en Hecho (Done) responda a Guardar Cambios? (Save Changes?) con un “Sí”, 
pero entonces responda a Sustituir Archivo Existente? (Replace Existing File?) con un “No” y use la caja de diálogo Guardar 
Como (Save As) para guardar la foto editada en la carpeta de su disco duro (Guardar En>Disco Local -Save In>Local Disk), 
no en el Disco Intercambiable (Removable Disk) [cámara].

 

Cómo descargar sus fotos – paso a paso continuación Cómo descargar sus fotos – paso a paso continuación
8. Si no tiene experiencia en la edición de fotos en un ordenador/computadora, consulte el menú Ayuda (Help) de su  
software (PhotoSuite tiene un menú de Ayuda extenso incorporado) para buscar consejos útiles sobre cómo usar estas  
funciones. Además de ajustar el brillo, contraste, nitidez y color de sus fotos, también puede redimensionar la fotografía para 
que quepa en el papel en que va a imprimirla, o guardarla en un archivo más pequeño con una resolución baja o mediana  
para enviarla por correo electrónico o insertarla en documentos. Cuando esté listo para guardar su archivo editado, puede  
usar Guardar Como (Save As) y dar al archivo un nombre más descriptivo que “BUSH0001”. De esta forma también  
puede preservar el archivo original como seguridad para reabrirlo y reeditarlo más tarde. Cerciórese de que ha transferido con 
éxito todas las fotos que quiso guardar antes de usar Borrar Todas (Delete All) en su cámara con el fin de crear espacio para 
nuevas imágenes.
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GARANTÍA LIMITADA DE DOS AÑOS

Su producto Bushnell® está garantizado contra defectos de materiales y fabricación durante 
dos años a partir de la fecha de compra. En caso de defectos bajo esta garantía, nosotros, a 
nuestra opción, repararemos o sustituiremos el producto siempre que lo devuelva con portes 
pagados. Esta garantía no cubre defectos causados por uso indebido, ni por un manejo,  
instalación o mantenimiento inapropiados realizado por alguien que no sea un departamento 
de servicio autorizado de Bushnell.

Cualquier devolución que se haga bajo esta garantía deberá ir acompañada por lo siguiente:
 1)  Un cheque /giro postal por la cantidad de 10 dólares para cubrir los gastos postales y 

de manejo
 2) Nombre y dirección donde quiere que se le envíe el producto.
 3) Una explicación del defecto.
 4)   Prueba de la fecha de compra.
 5)   El producto debe empaquetarse bien en una caja de cartón resistente para evitar que se 

dañe durante el transporte, y enviarse con portes pagados a la dirección siguiente:

EN EE.UU. enviar a:  EN CANADÁ enviar a: 
Bushnell Performance Optics  Bushnell Performance Optics
Attn.: Repairs   Attn.: Repairs
8500 Marshall Drive  25A East Pearce Street, Unit 1
Lenexa, Kansas 66214  Richmond Hill, Ontario L4B 2M9

En el caso de los productos comprados fuera de Estados Unidos o Canadá, póngase en  
contacto con su distribuidor local para que le den la información pertinente sobre la  
garantía. En Europa también puede ponerse en contacto con Bushnell en:
 BUSHNELL Performance Optics Gmbh
 European Service Centre
 MORSESTRASSE 4
 D- 50769 KÖLN
 ALEMANIA
 Tel: +49 (0) 221 709 939 3
 Fax: +49 (0) 221 709 939 8

Esta garantía le ofrece derechos legales específicos.
Puede que tenga otros derechos que varían de un país a otro.

©2004 Bushnell Performance Optics

Tamaño 
de imagen

Megapixels 
(aprox.)

Calidad * Memoria 
interna 

64 MB 
Tarj. SD 

2048x1536 3.2 FQ 10 fotos 39 fotos

NQ 20 79

EQ 41 158

1600x1280 2.1 FQ 16 64

NQ 33 129

EQ 67 259

1280x960 1.3 FQ 26 101

NQ 53 202

EQ 106 405

1024x768 0.8 FQ 41 158

NQ 82 317

EQ 165 634

800x600 0.5 FQ 67 259

NQ 135 519

EQ 271 1038

Referencia de la capacidad de almacenamiento de fotos  (capacidad máx., +/- 2 fotos)

* Selecciona la cantidad de compresión del 
archivo (jpg ratio)
(FQ=baja/EQ=alta)
FQ: Calidad fina (1:2.5)
NQ: Calidad normal (1:5)
EQ: Calidad económica (1:10)

El tamaño de la imagen se refiere a la dimensión 
en pixels, o resolución, del archivo digital. 
 
La capacidad de almacenamiento real variará 
de acuerdo con el contenido de cada archivo 
fotográfico. Es posible que pueda tomar unas 
cuantas fotos más o menos que la capacidad 
media listada. 

Use configuraciones de tamaño grande y alta 
calidad en el caso de las fotos que luego quiera 
ampliar o recortar. Si fuera necesario, también  
se pueden reducir a un archivo de menor  
tamaño usando el software de fotografías.  
Use configuraciones de tamaño pequeño  
o calidad baja cuando vaya a enviarlas por  
correo electrónico, insertar en documentos,  
o hacer copias pequeñas, y si no desea  
redimensionar el archivo después.

NOTA DE FCC:
Este equipo se ha sometido a prueba y se ha encontrado que 
cumple con los límites de los dispositivos digitales de la Clase 
B, de conformidad con la Parte 15 de la reglamentación 
de FCC. Estos límites se establecen para ofrecer una 
protección razonable contra interferencias perjudiciales en 
una instalación residencial. Este equipo genera, usa y puede 
emitir energía de radiofrecuencia, y si no se instala y usa 
de acuerdo con las instrucciones, puede causar interferencias 
perjudiciales a las comunicaciones de radio. Sin embargo, no 
hay garantía de que no se produzcan interferencias en una 
instalación particular. Si este equipo causara interferencias 
perjudiciales a las recepciones de radio o televisión, lo cual 
se puede determinar encendiendo y apagando el equipo, se 
aconseja al usuario a que intente corregir la interferencia 
aplicando una o más de las siguientes medidas:
· Reorientar o reubicar la antena receptora.
· Incrementar la separación entre el equipo y el receptor.
·  Conectar el equipo a un enchufe que esté en un circuito 
diferente que el del receptor. 

·  Consultar al distribuidor o a un técnico de radio/TV 
experimentado para que le ayude.

Con el equipo se debe usar un cable de interfaz blindado 
para cumplir con los límites de los dispositivos digitales 
de conformidad con la Subparte B de la Parte 15 de la 
reglamentación de FCC.

Las especificaciones y los diseños están sujetos a cambios sin 
previo aviso ni obligaciones por parte del fabricante.
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Notas:


